
 

PaleoTax/Measure 

Program Release 1.1.1 (1 September 2011) 

Introduction 

What is PaleoTax/Measure? 

PaleoTax/Measure (short: PM) is a tool to measure two dimensional objects with a size of up to one 
meter. The resolution of PM is 0.001mm (1µm). It is only possible to measure distances, not yet areas 
(in preparation). The program is a clone of PaleoTax/Map, but here the total map size is not the globe 
but an area of 1 x 1 meter. It is (at the moment) totally independent of PaleoTax. A future version may 
be made available as a Plug-in for PaleoTax to ease measuring images administrated by PaleoTax. 

Why PaleoTax/Measure? 

 PaleoTax/Measure allows in a very short time span the recording of a high number of distances of 
various types (which the user can define). 

 Values obtained through PM are much more accurate than those taken manually with a ruler. 
 The program calculates automatically arithmetic mean, standard deviation, coefficient of variance and 

the first interval from the obtained values.  
 The program allows to export the measured data as a plain text file, which make it easy to import it in 

any spread sheet program.  
 Values can be classified and the results can be used in distribution analysis.  
 Data can be stored (in ASCII files) and reloaded, modified and completed. Values can be deleted 

from a table or directly in the image. 

What to measure? 

PaleoTax/Measure helps to measure any plane object such as photographed leafs, any sectioned or thin-
sectioned object, biological preparations etc. The smallest distance which can be measured is 0.001mm 
or 1µm. The working area is 1x1m. The object to be measured must be available as JPG or BMP file. 
The resolution (or the scale) depends on the size of the object and the expected exactness. Is the scale 
too large, the work goes slightly slower because of the size of the image file; is the scale too small, the 
object appears blurred and makes exact measurement difficult. Some experience can help to clarify 
which is the best resolution. To get a first idea, divide the size of the area in µm (1000000) by the 
smallest value to be measured (in µm). Is the smallest distance 100µm, the resolution should be about 
10000dpi (1000000/100). Is the smallest value 2mm (1000000/2000), the recommended resolution is 
500dpi. A slightly higher resolution gives more exact results. Objects to be measured must be available 
as files. JPG gives smaller files; BMP gives larger files, but is faster. The maximum size of an image 
which can be processed depends on the main memory of your computer; if the image is too large, it will 
simply not be displayed. It is not possible to quantify that; count 20MB JPG file size for each free 
500MB main memory in your computer as a maximum. 
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What is new in this version? 

Compared to the former version (1.0) the following important changes were made: 
 Display speed is much higher. 
 Segments can be deleted from the table or in the image. 
 More statistical values are calculated.  
 Results are displayed in a table. 
 More output formats. 

Compared to the former version (1.1) the following changes were made: 
 The program works generally better under Windows Vista and higher versions. 
 It can be selected which values are given in the Screen output format. The output text can 

automatically transferred into the Windows clip board. 
 It became easier to append new data types. 

Equations 
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Coefficient of variation according to K. Pearson  *100/µ 
First interval µ±  
Range – percentage of the values which falls in the first interval. 

How to use the program 

Installation and Un-Installation 

PaleoTax/Measure forms either part of the Hdb2Win/PaleoTax database package or comes in a separate 
package. It depends on your needs, but the separate version is more frequently updated whereas the 
package version is only updated when the whole package makes a step to a new version. Download 
either the Hdb2Win (package) installation file from http://www. paleotax.de/pvn4.htm or the separate 
version from http://www.paleotax.de/measure and run the installation program (at the time of writing 
this documentation it is hdb232.exe for the whole package or pm111.exe for only PaleoTax/Measure). 
You probably should have administrator rights to do so. If you only want to use PaleoTax/Measure, you 
should download and install pm111.exe, if you want to use the database program as well download and 
install hdb232.exe. To remove the program from your PC use the functionality of the operating system 
(Start / Control / Programs) uninstalling “PaleoTax / Measure 1.1 (only uninstall)” or “Hdb2Win 2.3.2 
(only uninstall)” respectively. The un-installation program is also installed in the program folder; you 
may find it in Start / All programs / [program].  Newer version requires un-installation first. Your 
data and settings will not be touched by removing the program from the computer.  
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Get started 

Starting PM you will see a menu, a tool bar, the working area, a bottom status bar and - on the right 
hand side - two tables (the upper for the values, the lower for the results). The language is per default 
set to English, if it is for any reason (perhaps because of an older installation) German and you want to 
change it, choose “Optionen”, and select behind “Sprache” the English language. You need to restart 
PaleoTax/Measure. Configuration files are kept in c:\Users\<username>\AppData\Roaming\Hdb2Win\. 

 
To start to measure, open the file menu, choose “New” (or press Ctrl-N) and select a bitmap file (JPG 
or BMP). You will be asked to enter the resolution of the image. The resolution is the value you choose 
in your scanner when scanning the object/thin section/peel etc. If you have not scanned the object 
yourself, it should have at least a scale bar. Open a program to handle bitmap files and measure the size 
of this scale bar in pixel. Let's assume the scale bar represents five millimetres and you measured a length 
of 420 pixel, you should enter the value as “420/5”. See the examples below. 



 PaleoTax/Measure 1.1.1 4 

  
 
The program will recognise that you have not entered a resolution and calculates the correct resolution. 
After having chosen a graph file and entering the resolution, the image is displayed in the working area 
with the correct resolution given in the status bar. 

 
Now you can enlarge or reduce the size of the image, see parts (holding the left mouse button down and 
draw a rectangle to the lower right) or return to the original size by clicking on the world symbol. With 
the magnification tool you can reduce (+) or enlarge the size of area stepwise (-).  
To measure values, click on the pin tool. Then click at the first point of the line to be drawn (measure). 
If you have not chosen before a distance type from the top selection box just on the right hand side of 
the tool bar, a menu will open to offer you the standard tools. 

 
Per default, there are five different objects types: points (optional with a label), lines with various points, 
polygons, texts and two point lines. You may use all but only two point lines (TPLs) will allow you to 
measure and calculate values. You can select the available TPL data type 155, but you may also create 
your own data types. To do so, click on “New”. 
But, before starting, some considerations are recommended. A plane object allows to measure – depen-
ding on its shape and characteristics – various types of values. If you have a leaf, you can measure the 
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height and width and some subsequent values depending on the type of leaf. If you measure a more 
complicated object like an foraminifer or a coral, much more values can be obtained (see the example 
below). It is useful to address each data type with a different TPL type (which you will create clicking 
on “New”). It is a good idea to make first a list and put the most used data types at the top and create 
them first. It easy to create them through the menu item Edit / New data type. 

 
If you create a new data type, the (default) properties of the last used data type are copied into this data 
type. If there is no formerly data type, the standard values of the TPLine are applied (see the figure on 
the next page, top). Enter a name in the field, preferably in the form “abbreviation (explanation)” and 
adapt line colour and thickness to your needs. Only if you append a new data type, you may change the 
object type (line, point, etc.). If you have already a list of data types and you want to append them, 
choose the item “New data type” in the Edit menu.  
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Systematic description  

Menus 
File menu 
New (^N) – New project. Selection of an image file (JPG, BMP) and entering a resolution. 
Open (^O) – Opens an existing (PMP, PaleoTax Measure Project) file. This file contains (in the ASCII 

format) the path and name of the image, its resolution, and already recorded data. If the image file 
is not found, you may select it manually. 

Save (^S) – Saves the current project. If no name has been so far assigned to the project, you have to 
choose the path and to enter the file name. Please note, that the image is not saved in the project 
file, just its position on your hard disk is saved. So do not remove the image file.  

Save as – Saves the current project under a different or new name.  
Export – Offers various options.  

WMF  WindowsMetaFile.  
BMP  Bitmap.  
Text  Exports the values as ANSI file which can be imported in any spread sheet 

application. It classifies values according the value Options / Display / Class Size. 
The unit of the class size is always µm.  

Screen Summarises the calculated values for all measured types in form of a short report 
without giving the detailed data. You may preset the values you need in Options / 
Export / Output "Screen". 

PaleoGraph Writes a PGR file of the first three values which can be displayed in 
PaleoTax/Graph. Class size as above.  

Properties – Gives information about the current project. 
Reset (^R) – Closes the current project. You are asked if you want to save the current project. 
Exit (ALT+X) – Leaves the program. 
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Edit menu 
Refresh – Refreshes the display. Space key makes the same.  
Object characteristics – Offers the possibility to modify colour, line length etc. of the various data  types. 
New data type – Appends a new data type. 

View menu 
All – Shows the whole image. 
Reduce – Reduces the size of the image. The percentage value can be modified in the options. 
Enlarge – Enlarges the size of the image. The percentage value can be modified in the options. 

Options menu 
Data/System 
Data path – Path for the PaleoTax Measure Project files. 
Object file – Name of the file which contains the description of objects. 
Bitmap folder – Name of the current image folder. 
Pool folder (Images) – This is a folder name where the program may search for images if there are not 

found in the original folder.  
Language – Language of menus etc.  
User data – Amount of records which can be recorded by the user at the same time.  
Display warning errors – If marked, also warning errors are shown (generally just for testing the 

software). 
Registered for – Registration is currently not necessary.  
Display 
Enlarge (+) by – Percentage of enlargement when the + key is pressed, the Enlarge command used from 

the View Menu or clicked in the + tool. 
Reduce (-) by – Percentage of reduction when the - key is pressed, the Reduction command used from 

the View Menu or clicked in the - tool. Enlarge and reduce should be proportional values. This 
does not man that they are identical (because they are percentages). Valid pairs are 80–125 (with a 
very low rate of enlargement and reduction), 40–250, 20–500 and 10–1000 (a very high rate).   

Fine scaling – Percentage of enlargement or reduction when the up or down arrow is clicked in the 
magnification tool in the toolbar.  

Partition raster – Number of horizontal and vertical grid lines on the working area. 
Distance grid labels – Distance of grid labels from the grid lines. 
Minimum zoom size – The smallest size (in pixel) when a new frame is selected by pressing and holding 

the left mouse button and drawing the window.  
Width of measure area – To obtain a correct scale bar, you should measure the width of the measure 

area (in mm) on your screen and enter here. 
Unit of the table of values – Select the unit which should be used in the table and export.  
Snap to grid – If marked, the selection of a smaller working area orientates on the grid.  
Hide unselected values – During data recording all data which do not belong to the currently recorded 

type are shown as black thin lines. 
Background colour – Background colour of the working area. 
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Transparent colour – Colour in images to be transparent, say, any pixel with this colour in the imported 
image will show the background colour. 

Change layer order – Modifies the order of the different layers in the working area. You do not need to 
change that, but if you like, you may switch off the histogram ("(9) Statistics").  

Adapt export to CDR – Only valid for the export to the WMF format to avoid problems when importing 
the WMF file into CorelDraw (can be also the case for other vector oriented drawing programs). 

Ask for names ... – Asks for names for any point, or point of a line or polygon. 
Class size – Size of the class when exporting data as text files and showing as diagram in the display. 

The unit is always µm. Class size should be ca. 3% of the average of the measured values. If for 
instance, the average of your values is 2mm, the approximate class size should be 60µm. It is 
possible to calculate the class size always on the base of a given percentage of the average (see 
below). - Switch the layer (9) on to see how values are distributed.  

% of the average – Enter here the percentage of the average for calculation the class size. Value must be 
between 1 and 99. 

Export  
Adapt class size – If switched on, the class size will be calculate as a percentage of the average. 

Calculation will be made after any change of values.  
Output "Screen" – List of values which are shown in the Screen output mode.  

Working area 

The working area is always quadratic, e.g. height and width have the same size (this makes calculation 
much easier). There is a grid which density can be controlled by the user. In the left lower corner is a 
small scale which only works if you enter the size of the working area in mm on your screen. To do so, 
you should start the program, adapt its size to your needs or the screen size, take a ruler and measure 
the value of the area. The value (mm) you enter in the options (Width of measure area). If the value is 0 
(per default), no scale will be displayed. If layer (9) is switched on, in the lower right corner a diagram is 
displayed which shows the distribution of the measured values. Class size according to the value defined 
in the options. 

Toolbar 
Plus tool – Enlarges the size of the image. The percentage value can be modified in the options. 
Minus tool – Reduces the size of the image. The percentage value can be modified in the options. 
World tool – Shows the whole image. 
Magnification tool – Enlarges or reduce the size of the image in small steps. The percentage value can 

be modified in the options. 
Grid tool – Increments or decrements the number of grid lines. 
Pin tool – Activate to record data. 
Move tool – Activate to modify the position of points. 

Status bar 
Field 1 – Name of the project (or image) and its resolution. 
Field 2 – Factor of  magnification (do not forget to enter the screen size in the options!). 
Field 3 – Width of the image area in mm. 
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Field 4 – Size of the image in pixel (size in KB/MB). 
Field 5 – Amount of recorded data, percentage of used space and status of being saved or not. 

Tables 
Top selection box 
Here you can select the type of values you will take before selecting the pin-tool. Values of this type will 
be displayed in the tables. 

Values (upper) table 
The table lists the values of a selected measure type (and only for this type!). Double click in a cell to 
remove values from the table. Be sure that you have chosen the correct cell. You have to click in the 
field of the value, not in that of the current number. Smallest and highest values are marked. 

Results (lower) table 
The following results are given: 
n – Number of measured values. 
min – Minimal value. 
max – Maximal value. 
Arithm.mean – Arithmetic mean ( ) on the recorded values. 
Variance – Variance of the recorded values.  
Stand.Desv. – Standard deviation ( ) of all the recorded values. 
s*100/µ – Coefficient of variance according to K. PEARSON. 
µ±s – The amount (in percent) of measurements which falls into the (first) interval , which gives a 

first idea about the distribution of data.  
Range – Amount of measurements which fall into the interval  and . 
Make proposals what else would be interesting for you. Give equations; function(s) can easily be 
incorporated. See on the next page a typical picture - here the diameters of corallites of a fossil colonial 
coral. 

Copyright information 
The right to use the program freely without paying any fee does not imply that the program is without 
copyright. If you use the program in your research and you will mention its application in the method 
section of your publication(s), please refer to it in the following way  
“PaleoTax/Measure 1.1 (http://www.paleotax.de/measure, © Hannes Löser)” 
The program has been developed within the framework of my duties as researcher and lecturer at the 
Universidad Nacional Autónoma de México (UNAM) and my university has the right to ask for 
references to products of its faculty members. I would be grateful for receiving PDF files of your 
publications where PaleoTax/Measure is mentioned. 
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